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TurboBPR Version 2.5

TurboBPR 2.5 is a Windows-based business process reengineering support tool 
developed by OSD C3I (IM).  TurboBPR helps you respond to BPR, GPRA, and business
planning requirements by:

· Capturing the essential elements of strategic planning, operations analysis, 
and project evaluation through accepted frameworks.

· Highlighting and maintaining the linkages between related plan elements.  For
example, TurboBPR helps you connect goals to initiatives.

· Providing both on-screen guidance and a comprehensive help system to assist 
users in strategic planning, functional economic analysis, and business process
reengineering.  More than just assistance in operating the software, TurboBPR
user help includes guidance, suggestions, and examples.

· Automating cumbersome cost computations, assisting with the clerical tasks, 
and summarizing the elements of your work in ASCII text or a formatted 
Microsoft Word document.

What's New in TurboBPR Version 2.5

TurboBPR 2.5 provides several new features which enhance its flexibility.  You can now:

· Import initiative cost data from a Microsoft Project file.
· Create detailed worksheets to describe your initiative impacts upon 

performance.
· Attach initiative-specific notes for initiative costs, performance impacts, and 

cost impacts.
· Print your detailed worksheets directly from TurboBPR or have them included

in the Microsoft Word report.
· Expand your detailed worksheets to full-screen size for easier editing.
· Paste worksheet values between sheets.
· Include up to 50 years of data (as opposed to 20) for each performance 

measure, initiative, and the AS-IS operations costs.

In addition, the contents of the TurboBPR report appendix have been broadened, and the 
Answers to Common Questions topic has been reorganized and extended.
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TurboBPR Tutorial
Version 2.5

This tutorial guides you through all five TurboBPR modules using a fictional Functional 
Economics Analysis (FEA) scenario.  Please note that this scenario is for exposition only. 
All data have been fabricated or revised for simplicity.

During the tutorial you will add data to a project, revise existing data, and interact with 
the software.  Please take the time to experiment with the software.  You cannot "break" 
the software by playing with it.

The tutorial consists of  eight lessons:

· Lesson 1: Getting Started
· Lesson 2: Strategic Planning
· Lesson 3: Operations Analysis
· Lesson 4: Initiatives
· Lesson 5: Alternatives
· Lesson 6: Actuals
· Lesson 7: Creating TurboBPR Reports
· Lesson 8: Using TurboBPR Converter

If you want to complete all the lessons in one sitting, it will probably take you about  3 
hours.  If you want to complete the tutorial over multiple sessions, you can easily save 
your work and return later.  Although the lessons build on one another, you may try 
jumping ahead.  Before starting the TurboBPR tutorial, you should be comfortable using 
Windows and a mouse.  

After completing the tutorial you will know:

· What data TurboBPR needs
· How to enter data into TurboBPR
· How to build linkages (relationships) between data in TurboBPR modules
· How to create reports using TurboBPR data
· How to convert projects from version 1 to version 2.5 of TurboBPR

For those who are unfamiliar with Microsoft Windows, you may find it helpful to refer to
the Windows Reference in the Appendix for help in understanding Windows elements 
before starting the tutorial.

11/10/94 3:26 PM

4



Typographical Conventions

General Conventions

The following kinds of formatting in the text identify special information.

Formatting convention Type of information
Bold type Names of buttons, tools, and other items that

execute. TurboBPR commands.
Italic type Words that appear on TurboBPR screens.
Monospaced font Words or characters that you type. 
CAPITAL LETTERS Names of files.
< > Place holders for items you must supply, such as filenames.
" " Input data already in database.
Initial Capital Letters New terms introduced.

Keyboard Conventions

All key names are shown in small capital letters.  For example, the Control key is shown 
as CTRL and the Escape key is shown as ESC (The keys on your keyboard may not be 
labeled exactly as they are in this tutorial).

RETURN key and ENTER key

These keys perform the same function in TurboBPR.  In the TurboBPR tutorial, "Press 
ENTER" means that you can press either ENTER or RETURN.

Shortcut keys

Keys are frequently used in combinations or sequences as shortcut keys.  For example, 
CRTL+A means to hold down the CTRL key while pressing A.  ALT, F, O means to press 
and release each of these keys in order.

Arrow Keys; HOME; END; PAGE UP; PAGE DOWN

You can use the UP ARROW, DOWN ARROW, LEFT ARROW, and RIGHT ARROW keys to 
move the insertion point in a text box or worksheet.  Some of these keys can be used in 
combinations, such as CTRL+HOME.
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Mouse Conventions

You can use either a single button mouse or a multiple button mouse with TurboBPR.

·  If you have a multiple-button mouse, the left mouse is the primary mouse 
button, unless you have configured it differently.  TurboBPR requires you to 
use the primary mouse button.

·  "Point" means position the mouse pointer until the tip of the pointer rests on 
whatever you want to point to on the screen.

·  "Click" means to press and then immediately release the mouse button without
moving the mouse.

·  "Double-click" means to click the mouse button twice in rapid succession.
·  "Drag" means to point and then hold down the mouse button as you move the 

mouse.

Tutorial Scenario: Logistics  
Throughout the tutorial you will use the SUPPLY.BPR scenario file provided with the 
TurboBPR Software.  This scenario is loosely based on an actual BPR success story in a 
DoD logistics function.  The details have been changed to better illustrate the use of 
TurboBPR.
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Lesson 1:  Getting Started
Approximate completion time: 15 minutes

After completing Lesson 1 you will know how to:

· Start TurboBPR
· Use the Menu Bar and Toolbar
· Use TurboBPR Help
· Open and save a file in TurboBPR
· Use TurboBPR Notes.

Starting TurboBPR

If you have not already started the TurboBPR program, double-click on the TurboBPR 
icon to start the program.  An introductory screen with a Start, Help and a Movie button 
will pop up.  If you would like a quick overview of TurboBPR before working through 
the tutorial, click the Movie button for an animated tour.  Now, click the Start button.

Using the TurboBPR Menu Bar and Toolbar

Notice the Menu Bar.  It provides the following options: File, Edit, Modules, Tools, 
View, and Help.  Click anywhere outside of the File menu to close the menu.  Below the 
menu bar is a Toolbar containing seven tools.  Pass the mouse over each tool.  A Tooltip 
describing each tool pops up as the mouse passes over the tool.

Using TurboBPR Help

Click the Help menu.  Then click Context Sensitive Help from the list under help.  
TurboBPR's context sensitive help will take you to different topics in the help file 
depending on the module you are in.  You're not in a TurboBPR module yet, so the Help 
system brought you to the Help Turbo BPR Workplace contents screen.

11/10/94 3:26 PM

7



Figure 1.1

There are ten major topics listed in green.  Notice how the cursor changes from a pointer 
to a finger as you pass it over the topics.  Click on Opening and Saving Projects.  The 
Opening and Saving Projects help screen appears.  Next, click on Opening an Existing 
Project.  The Opening an Existing Project screen appears.  Read the directions on the 
screen, because our next step will be to open a project.

Now let's return to TurboBPR from the Help system.  Double-click the TurboBPR Help 
control menu button (the small gray box in the upper left-hand corner of the screen)  to 
close the Help screen.

Opening a File

Now we're going to open the SUPPLY.BPR scenario file.  Click the Open File tool (it 
looks like an open yellow file folder).  An Open dialog box will appear.  On the left side 
of the dialog box is a list of all .BPR files in the TURBO2\FILES directory.  Double-click
on the file named SUPPLY.BPR.  An hour-glass will appear on your screen as the file is 
opened.  Your screen should look like this one:
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Figure 1.2

Using the Module Button Bar

The vertical group of five buttons on the left side of your screen is the Module Button 
Bar.  These buttons allow you to easily navigate through all the TurboBPR modules. 

Notice that after opening the scenario file several new tools are also available on the 
horizontal toolbar near the top of your screen.  Pass the cursor over each new tool to learn
what each represents.  

Saving Your TurboBPR File

Before you begin to work with the tutorial file, you should create a backup copy of the 
original project for future use.  To do this, click the File menu.  Click on the Save As 
option.  The Save As dialog box opens.  The cursor is in the box below File Name.  Click 
the DELETE key to clear the rectangle.  Type in SUPPLY1.BPR and click OK.  Now 
Click the File menu again and click the Close option.  SUPPLY1.BPR has now been 
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created as a backup of the original project file.  To open the original file and continue the 
tutorial, click on the File menu.  Click Open Project ... to open the Open dialog box.  
Type SUPPLY.BPR in the box below File Name and click OK to open the original project
file.

Using the Notes Feature

Click the Notes tool (a red notebook on the toolbar).  Your screen will contain this screen:

Figure 1.3

Each module screen has a separate note.  If a note is attached to the current screen, a 
"Notes Attached" message will appear in blue text on the right side of the horizontal 
menu bar near the top of the screen.  You can display the notes and print them as part of 
the documentation for your project.  You can also attach a separate note to the overall 
project.  We haven't opened a module screen yet, so the note on your screen now is the 
note for the overall project.  Let's add some text to the note on your screen.

Use the mouse to position the cursor at the end of the paragraph, and hit ENTER to start a 
new line.  Type Project modified by <Your Name>.  Then click OK. 
The notes screen will close.
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Lesson Summary

You've now learned the basics of working in the TurboBPR environment.  Next you'll 
learn about working in the Strategic Planning module.
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Lesson 2: Strategic Planning
This lesson consists of two sections on how to do strategic planning in TurboBPR 2.5.
The combined approximate completion time for both is: 40 minutes

You will learn how to:

· Add Goals, Performance Measures, and Strategies
· Link a Strategy to multiple performance measures
· Delete Goals, Performance Measures, and Strategies
· Cancel your changes
· Use the Mission and Vision Statements Screen
· Use the Goals: Details Screen
· Use the Performance Measures: Details Screen
· Use the Strategies: Details Screen

Section 2.1 Using the "Strategic Plan Overview" 
Screen
Approximate completion time: 25 minutes

After completing Section 2.1 you will know how to:

· Add Goals, Performance Measures, and Strategies
· Copy a Strategy to multiple performance measures
· Delete Goals, Performance Measures, and Strategies
· Undo your changes

If you haven't already done so, open the file SUPPLY.BPR.  Click on the Plan module 
button. The Strategic Plan Overview screen appears and your screen should look like 
this:
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Figure 2.1

Understanding the Screen

Let's take a moment to look at the screen before we start to work.  Almost all of the 
TurboBPR 2.5 windows have OK, Cancel, and Info buttons.  Use the OK and Cancel 
buttons to either save or discard the changes you made since you last opened a screen.  
Use the Info button to get brief data entry instructions for the screen.  Click the Info 
button now to read the instructions for this screen.  

As mentioned in Lesson 1, TurboBPR 2.5 also provides context sensitive help which is 
custom-tailored assistance.  Whenever you select the Help command from within a 
module, the help topic related to the TurboBPR 2.5 screen that you're using appears.  
While in the Info screen, click on the Help button.  The Strategic Plan Overview Window 
section of Help will appear.  You may read some this section before continuing with the 
lesson.  Close the Help screen when you are done reading (double-click on the small gray
box in the upper left-hand corner of the screen), then click OK to return to the main 
screen. 

The Strategic Plan Overview screen also has Add and Delete buttons.  Use them to add 
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or delete goals, performance measures, and strategies from your strategic planning map.

Note:  The captions on the Add and Delete buttons describe the actions you can take 
when the current row is highlighted.  Click once on the GOAL-PERFORM-STRATEGY 
row.  Notice the Add button now says Add Goal.  Click once on P2 "Average logistics 
overhead rate".  The Add button now says Add Strategy and the Delete button says 
Delete Perform.

Mapping Rules

At the bottom of the screen is the strategic planning map.  Notice that each goal must 
have at least one performance measure.  Likewise, each performance measure is affected 
by at least one strategy.  

As illustrated in Figure 2.1, a performance measure can map to one and ONLY one goal.  
A strategy can map to one or more performance measures.  Performance measures 
supported by a common strategy do not have to map to the same goal (see "Strategy 1" in
Figure 2.1).

Adding Goals and Performance Measures

Let's add a goal to the database. Click the left mouse button once to highlight the GOAL-
PERFORM-STRATEGY row.  The row is now selected.  Click the Add button once.  A 
goal with a default title appears at the bottom of the strategic planning map.  If you can't 
see the goal, use the vertical scroll bar on the right side of the screen to scroll down.

When you add a goal, performance measure, or a strategy to the database, it appears with 
a default title until you change it.  The goal you just entered has the default title "Goal 
Number 4".

To link a performance measure to a goal, you select the goal first, then click the Add 
button.  Let's link a performance measure to "Goal Number 4".  Click the left mouse 
button once on "Goal Number 4" to select it.  Click the Add button.  A performance 
measure titled "Performance Measure Number 4" will appear.  Your screen should now 
look like this:
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Figure 2.2

Copying Strategies

You can add strategies to performance measures by using the Add button just as you 
linked performance measures to goals.  However, since a strategy can map to one or more
performance measures, TurboBPR provides another way to enter strategies.  If a strategy 
is already in the database, you can copy it to another performance measure.

Strategy S1  "Implement state-of-the-art commercial best practices" is already linked to 
two of the performance measures in the database.  Let's copy "Implement state-of-the-art 
commercial best practices" to "Performance Measure Number 4".  

Click the left mouse button once on "Implement state-of-the-art commercial best 
practices" to highlight it.  Choose the Copy command from the Edit menu.  Now click 
the mouse button once on "Performance Measure Number 4" to highlight it.  Choose the 
Paste command from the Edit menu.  "Implement state-of-the-art commercial best 
practices" has been copied to "Performance Measure Number 4".  Your screen should 
look like this:
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Figure 2.3

Deleting a Strategy

Suppose you decide that strategy S1 "Implement state-of-the-art commercial best 
practices" doesn't provide any measurable improvement to P4 "Performance Measure 
Number 4."  You can delete "Implement state-of-the-art commercial best practices"  from 
"Performance Measure Number 4."

Under the performance measure "Performance Measure Number 4" , select the strategy 
"Implement state-of-the-art commercial best practices" and click the Delete button.  The 
strategy "Implement state-of-the-art commercial best practices" and the performance 
measure "Performance Measure Number 4" are now unlinked.  Your screen should look 
similar to Figure 2.2.

Canceling Your Changes

If you make changes that you do not want to keep, you can sometimes reverse or undo 
them.  The Cancel button undoes ALL of the changes you made to the data since the last 
time you saved the project or opened another screen.   
11/10/94 3:26 PM
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Let's undo all the changes we've made since the last time we saved the file.  Click the 
Cancel button.  Now click the Plan module button.  Your screen should now look like 
Figure 2.1 since none of your previous changes were saved.  
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Section 2.2: Entering Strategic Planning Data
Approximate completion time: 15 minutes

After completing Section 2.2 you will know how to:

· Use the Mission and Vision Statements Screen
· Use the Goals: Details Screen
· Use the Performance Measures: Details Screen
· Use the Strategies: Details Screen

Understanding the Mission and Strategic Vision Statements 
Screen

If you haven't already done so, click on the Plan module button so that the Strategic Plan 
Overview screen appears.  To open the "Mission and Strategic Vision Statements" screen,
click on the Mission & Vision button.  Your screen should now look like this:
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Figure 2.4

The mission statement should clearly state the primary purpose of the function.  The 
strategic vision statement is the guidance for future action and the basis for the 
development of your functional goals.

Read the mission and vision statements for Supply.  Click OK to close the Mission and 
Strategic Vision Statements screen and return to the Strategic Plan Overview screen.

Understanding the Goals: Details Screen

  Double-click "Reduce logisitics response time for materiel".  The Goals: Details screen 
appears and your screen should now look like this: 
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Figure 2.5

You use the Goals: Details screen to enter and edit information about your functional 
goals.  In this screen you can type in:

1.  A title for the goal in the Goal text box.
2.  A description for the goal in the Goal Description text box.
3.  In the Related Goal(s) in Other Plan(s) text box, a listing of goals from other 

strategic plans that are related to the current goal.

Read the description for "Reduce logisitics response time for materiel".  Notice how it 
describes the relationship between the goal and the vision.  Goals should be created to 
realign a function with its vision.

Click OK to close the screen and return to the Strategic Plan Overview screen.
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Understanding the Performance Measure: Details Screen

  In the Strategic Plan Overview screen, notice that the goal "Reduce logistics response 
time for materiel " is linked to the performance measure "Percent orders delivered within 
3/5 days".  The achievement of each goal must be measurable.  The way you measure the 
achievement of a goal is by linking it to a performance measure.  

Double click the performance measure "Percent orders delivered with 3/5 days".  The 
Performance Measure: Details screen appears and your screen should look like this:

Figure 2.6

You will use the Performance Measure: Details screen to enter and edit information 
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about performance measures.  In this screen you can enter:

1.  A title for the performance measure in the Performance Measure text box.
2.  A description of the measure in the Performance Description text box.
3. Detailed information about the measure: type of measure, unit of measure, 

starting and ending years for historical and target performance ranges, and the 
historical and target values for those years.  

Entering Performance Measure Details

Click the mouse on the Type of Measure list box.  A list of the various types of 
performance measures appears.  Since "percent orders delivered within 3/5 days" gauges 
the amount of time it takes for supplies to reach the customer, it is a "Timeliness" 
measure.  

Now let's practice entering numbers into the worksheet.  Suppose the 1994 the percent of 
orders delivered within 3/5 days was actually 45 (not 50 as is already reported).  Type 
45 in the 1994 cell and hit ENTER.  We want to increase the percentage of orders 
delivered within 3/5 days by 5 percent a year, so in the target value cell for 1995 enter 
50.  In the 1996 target cell, type 55.  In the 1997 cell, type 60, and so forth until you 
reach 2000, where you would type 80.  

Now, click Cancel to close the screen and undo ALL your changes to the data.  The 
Strategic Plan Overview screen reappears.  

Understanding the Strategies: Details Screen

  Now that we know where we want to go (the goal) and how to tell when we get there 
(the performance measure), let's figure out how to get there (the strategy).  In the 
Strategic Plan Overview screen, the strategy "Improve readiness planning process" is 
linked to the performance measure "Validated plans for meeting surge requirements".  
Double-click on this strategy.   The Strategies: Details screen appears.  Your screen 
should look similar to this:
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Figure 2.7

You use the Strategies: Details screen to enter and edit information about strategies.  In 
this screen you can enter:

1.  A title for each strategy in the Strategy text box.
2.  A description for each strategy in the Strategy Description text box.

You enter information in this screen the same way you did in the Goals: Details screen. 

At the bottom of the Strategies: Details screen is a table that lists all the performance 
measures and related goals that the strategy affects.

Read the strategy's description to see how it relates to the performance measure 
"Validated plans for meeting surge requirements".  Click OK to close the screen.  Once 
you are back in the Strategic Plan Overview screen, click OK to close the screen.
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Lesson Summary

In this lesson, you learned how to:

· Add Goals, Performance Measures, and Strategies
· Link a Strategy to multiple performance measures
· Delete Goals, Performance Measures, and Strategies
· Undo your changes
· Use the Mission and Vision Statements Screen
· Use the Goals: Details Screen
· Use the Performance Measures: Details Screen
· Use the Strategies: Details Screen

In the next lesson, you will learn how to perform operations analysis in TurboBPR.
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Lesson 3: Operations Analysis

This lesson consists of three sections on how to do operations analysis in TurboBPR 2.5.
The combined approximate completion time for all three sections is: 50 minutes

After completing Lesson 3 you will know how to:

· Enter AS-IS Operations Cost
· Edit and transfer data from detailed worksheets to Operations Costs screen
· Modify an Activity Tree
· Enter Activity Based Costs
· Add and Delete Products and Services
· Enter data for Products and Services
· Allocate Activity Costs to Products and Services

Click on the Operations button in the module menu bar.  Your screen will look like this:
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Figure 3.1

The Operations Analysis screen has five large buttons arranged in a flowchart.  They are:

1.  Enter AS-IS Operations Costs button.  
In this module, you will enter forecasted AS-IS Oprations Costs.

2.  Define Activity Tree
In this module, you will construct and modify an Activity Tree. 

3.  Allocate Costs to Activities
In this module, you will enter activity based costs.

4.  List Products and Services
In this module, you will add, delete, and enter data for products and services.

5.  Calculate Product Costs
In this module, you will allocate activity costs to products and services.
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Section 3.1  Entering and Editing AS-IS 
Operations Costs
Approximate Time: 15 minutes

In this lesson you will learn how to:

· Enter AS-IS Operations Costs
· Edit and transfer data from detailed worksheets to Operations Costs screen

Click on  the Enter AS-IS Operations Costs button in the Operations Analysis screen.  
Your screen will look like this:

Figure 3.2

In this Module you will forecast AS-IS Operations Costs assuming no change in current 
operations.
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Selecting  the Unit of Measurement and Years for Analysis

At the top right-hand side of the screen, the Units list allows you to select the units in 
which your costs will be expressed.  Next to the Units at the top of the screen there are 
four boxes for entering in the years of your analysis.  These have already been filled in 
for you.  The boxes labeled Historical Costs for: are where you enter the period of  
historical operation costs for your analysis.  In this example, we chose only one historical
year --1994.   Hence, the start and end year are both 1994.  The boxes labeled Projected 
Costs for:  are where you enter the future years that you want to include in your analysis. 
The graph and the worksheet expand and contract with any changes in the range of years.

First we'll lengthen the range of years of analysis.  Click on the ending projection year
.  Highlight the year "2000" and hit the delete key on the keyboard.  Now type 

2005 and hit ENTER.  Click on the worksheet and use the horizontal scroll bar to move
to the right of the worksheet.  The table has been expanded to include the additional 
years.  Notice that zeroes are placed in the additional years.  You can experiment by 
entering numbers in these cells.  The graph will be updated to correspond to your 
changes.  In the next section we'll examine a detailed worksheet that supports your Total 
Ops Costs displayed here.  Click Cancel to exit the screen so that the original numbers 
will not be overwritten.  

Understanding Detail Worksheets

Click on the Enter AS-IS Operations Costs button.  Your screen will look like Figure 
3.2.

Now click on the Detail button.  Your screen will look like this:
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Figure 3.3

There are several places in TurboBPR 2.5 where you can enter detailed information in 
Excel-type worksheets.  All detailed worksheets work the same way, so once you 
understand this one, you will know how to use all of them.  

You can either import a worksheet or create one in this screen.  You can import an Excel 
4.0 worksheet into TurboBPR by clicking the Import button and selecting a worksheet to
import.  Or, you can edit a worksheet directly in this screen.

Near the top of the screen is a one-row worksheet with the Total Ops Cost from the 
previous screen.  In the lower part of the screen is a larger worksheet that looks much like
MS Excel or Lotus 1-2-3.  Now click on this worksheet.  Scroll bars will appear on the 
right and bottom of the worksheet.  These enable you to scan the entire worksheet.  In 
addition, the Expand button allows you to increase the size of the worksheet to a full 
screen.  You may enter detailed data in this worksheet to support your Total Ops Cost on 
the previous screen.  
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Editing a Worksheet

For future reference, to find detailed information about worksheets, click on Help / 
Contents / Other Appendices / Worksheet Functions.  Let's now edit this worksheet.  
Click the Expand button so that the worksheet is enlarged to fill the whole screen.  Use 
the horizontal scrollbar to move to the right so that column I is in view.  In the cell I3 
type =sum(B3:H3) and hit ENTER.  This will assign the value equal to the sum of all 
cells between (and including) B3 and H3 to the cell I3.  Click on the cell I3.  Click Edit 
from the menu and then click Copy.  Now click on I3 and drag the mouse down until 
cells I4-I7 are highlighted (in black).  Click Edit then Paste from the menu.  You have 
now entered a formula to add a list of numbers on a row and copied it to other rows.   

Transferring Data in a Worksheet

Click on cell B3 (it should contain the number 30).  Type 35 and hit ENTER.  Now click
OK to return to the Details windows.  Notice that the sum in cell B9 has changed from 80
to 85 after increasing 1994's labor costs to 35.  Click on any number in the TOTAL row 
(row 9).  Then click on the Transfer Row to Total button which is located at the bottom 
right-hand side of the screen.  The TOTAL row should now be transferred to the top Total
Ops Cost table.  The operations costs portion of your screen should look something like 
this:

Figure 3.4
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This is an example of how you would transfer a row in the worksheet to the Total Ops 
Cost row above.  Click Cancel to exit without saving this change.  Notice that the Total 
Ops Cost for 1994 is still 80.  Now click OK or Cancel to return to the operations 
analysis screen.
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Section 3.2 Activity Trees and Activity Based 
Costing
Approximate completion time: 20 minutes

After completing Section 3.2 you will know how to:

· Modify an Activity Tree
· Enter Activity Based Costs

Modifying An Activity Tree

First, you will need an Activity Tree.  Start the Operations Module by clicking  
Operations on the Module Button Bar.  Then click on Define Activity Tree.

This will bring up a screen that looks like:

Figure 3.5
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This is the Provide Materiel Activity Tree.  Notice the activity tree is composed of white 
rectangles labeled with Node Identifiers (A1, A2, etc.) and connected by black lines.  The
rectangles contain the names of the activities and the lines indicate Parent and Child 
relationships among the nodes.  The child nodes represent the activities involved in 
performing the parent node activity.  

The A0 Node has three children: A1, A2, and A3.  These three nodes comprise the first 
level of the activity tree.  Activities A21, A22, A23, and A24. comprise the second level 
of the activity tree. TurboBPR restricts you to six activities per parent node and two 
levels down of detail (i.e., A0 to A66).  

Notice the Add Child Node and Delete Node buttons that appear in the upper left corner 
of your screen.  

Adding Activities

Highlight the A3 node by clicking on the circular button to the left of the A3 label.  Click 
Add Child Node.  A white rectangle labeled "A31" should appear under activity A3.  In 
that rectangle type in Collect Information.  Make certain that A3 is 
highlighted and click Add Child Node again.  A white rectangle labeled "A32" should 
appear.  Name this activity Distribute Information.  Now Activity A3 is a 
parent with two children, "A31 Collect Information" and "A32 Distribute Information."  

Deleting Activities

Let's say you decide that having A31 and A32 provides too much detail, you can delete 
them.  Highlight Node A32 and click Delete Node. "Distribute Information" will be 
deleted. Repeat the procedure for the "Collect Information" activity.  

Click Cancel to undo your changes and exit the Activity Tree screen.  Now that you have 
an activity tree, you can allocate the cost of your business according to these activities.     

Entering Activity-Based Costs

Click on Allocate Costs to Activities.

This will bring up the Activity Cost screen which looks like:
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Figure 3.6

Understanding the Activity Costs Tree

Notice the Activity Costs Tree has the same structure as the Activity Tree.  However, 
below each Node Identifier there is both a white rectangular cell and a gray rectangular 
cell.  The white cell is where you enter activity costs.  The gray cell reports the 
percentage of total costs that the activity comprises.  You may not enter percentages into 
these gray cells.  TurboBPR will calculate the percentages automatically when the costs 
in the white cells change.

Entering ABC Data

The Activity Costs Tree allows you to enter the cost that each activity consumes.  
Observe, for example,  that activity "A23 Maintain Supplies" uses $ 32.   The A0 cell at 
the top of the tree represents the total cost.  A0 cost is equal to the sum of the costs of its 
children.  In this example A0 cost = A1 cost + A2 cost + A3 cost = $ 79.40.  Every parent 
node's cost must equal the sum of the costs of its children. 
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Locking and Unlocking a Cell

Notice that the total cost cell is shaded red.  The red shading indicates that the cell is 
locked.  Locking a cell means that TurboBPR will not overwrite any costs that you enter. 
You can unlock, and lock, a cell by double-clicking on it using the left button on the 
mouse.  Unlock cell A0.   Now click the mouse on cell A23 type in 300 and hit ENTER.  A
message pops up warning that changing the A0 cost will change the AS-IS Operations 
Cost forecast for the current year in module 2.  Notice that the total cost (A0) has 
changed to $371.40 million and the A23 cell is now shaded red.. Now unlock the A23 cell
so that there are no locked cells in the tree.  

How TurboBPR Allocates Cost for You 

TurboBPR allows you to input ABC costs in three ways: 

1) You can enter the total cost of an activity in a parent node, and TurboBPR will 
automatically divide the costs evenly across the children of the node;

Use the mouse to focus on the A2 cell.  Type in 0 (zero), hit ENTER, and then unlock the 
cell (double-click on it).  Now the cells of all the children of A2 (A21, A22, A23, and 
A24) should contain zeros.  Go to the top of the tree and in the A0 cell, type 20 and hit 
ENTER.  TurboBPR automatically divides the total cost evenly across the activities.  
Activities A1, A2, and A3 each receive $6.67 million.  The cost of A2 is evenly divided 
among its child node activities with each receiving $1.67 million.  

2) In this method you enter and lock-in total cost in the parent node and an amount in one
or more of the child nodes.  Remember that the sum of the children must equal the parent.

Now click on the A2 cell, type in 15, and hit enter.  TurboBPR locks the A2 cell and 
evenly divides the remaining dollars, so that activities A1 and A3 contain $2.50 million 
each.

3) You can enter costs in child nodes and TurboBPR will sum the cost to the parent node.

Unlock both the A0 and A2 cells.  Zero out the Activity Tree by entering 0 in the A0 cell 
and hitting ENTER.  Now unlock cell A0 and enter various costs in various nodes and 
observe how TurboBPR sums the costs at the parent levels.

Click Cancel to exit the Activity Costs screen without saving the changes.
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Section 3.3 Entering Products and Services Data

Approximate completion time: 15 minutes

After completing Section 3.3 you will know how to:

· Add and Delete Products and Services
· Enter data for Products and Services
· Allocate Activity Costs to Products and Services

Understanding the Products and Services Screen

Products and services are the outputs of an activity.  In this example, we will examine the
products and services of Logistics.  If you haven't already done so, click on the 
Operation module button so that the Operations Analysis flowchart screen opens.  Click 
the List Products and Services button.  The Products and Services screen opens.  Your 
screen should look like this:
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Figure 3.7

You will use the top of the Products and Services screen to add, delete, and select 
products and services.  In the bottom of the screen you can enter detailed information for 
the selected product or service.  You can enter:

1.  A title for the product/service in the Product/Service text box.
2.  The customers and stakeholders for this product in the Customer/Stakeholders text

box.
3. The annual volume and units for the current year in the Annual Volume and Units 

text boxes.

Note:  TurboBPR displays the unit cost for a product or service in the Unit Cost text box. 
The unit cost, which is always given in dollars, equals zero until you allocate activity 
costs to the products and services (which we will do later in this lesson).

Navigating Through Products and Services

For the moment, let's focus on the top of the Products and Services screen.

TurboBPR displays the products/services that you've entered in the Product/Service List 
box at the top of the screen.  Currently, Logistics has two products/services: "Peacetime 
supplies and equipment" and "Wartime materiel."  Notice that "Peacetime supplies and 
equipment" is highlighted in the list box.  That means that it is the selected 
product/service.  The detailed information for the selected product/service is always 
shown at the bottom portion of the screen.

Now click on "Wartime materiel."  This selects the product/service and displays its 
detailed information at the bottom of the screen.

Adding Products and Services

Click the Add Product/Service button.  All of the text boxes at the bottom of the screen 
should now be blank.  In the Product/Service text box overwrite "Product 3" with  
Mobile Wartime Facilities.  Use the TAB key to move to the 
Customer/Stakeholders text box.  In this box type Military members, 
Military Service Member.  In the Annual Volume text box type 200, and 
in the Units text box type facilities.

Deleting Products and Services

You can delete the product/service if it is selected (highlighted) in the Product/Service 
List box.  We are going to delete "Mobile Wartime Facilities" so make sure it's selected.  
Now click the Delete Product/Service button.  "Mobile Wartime Facilities" has been 
removed.
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Click Cancel to undo all your changes and close the screen.  The Operations Analysis 
flowchart screen reappears.

Understanding the Product and Service Costs Screen

From the Operations Analysis flowchart click on the Calculate Product Costs button.  
The Product and Service Costs screen opens.

You will use the Products and Services screen to allocate activity costs to the products 
and services of the function.  In some cases, the function allocates less than 100% of its 
resources to produce its products and services.  Activities with large unallocated costs are 
generally targets for BPR efforts.

At the top of the screen is a list box displaying the selected activity.  Click the left mouse 
button on the list box.  A list appears showing all the activity nodes in the activity tree.  
Click on "A0  Provide Materiel."

The worksheet in the middle of the screen shows the total cost allocated to the selected 
activity node.  In the first row, the total activity cost is displayed.  For the remaining 
rows, the first column displays the names of the products, the second column displays the
product costs, and the third column displays the percent of the selected activity costs 
allocated to the product.

Notice that all the cells in the worksheet are gray.  This means that you cannot enter data 
for the A0 activity.  In this worksheet, you can enter product costs for childless (lowest 
level) activity nodes only.  If a node is childless, the cells to the right of the product 
names will be white.  If a node has children, the cells to the right of the product names 
will be gray.

Beneath the worksheet, TurboBPR displays the unallocated costs.  The unallocated costs 
for an activity will equal 100% of the total activity costs until you allocate the activity's 
costs to the products.

Allocating Activity Costs to Products and Services

Select "A22  Receive Materiel" from the activity list box.  Notice that the cells to the 
right of the product names are now white.

The majority of the cost for A22 is personnel, but it is not 71%.  Therefore, let's update 
the percentages for A22.  Approximately 80% of the personnel handle "Peacetime 
supplies and equipment."  15% receive supplies to maintain "Wartime materiel."   Type 
80 in the third column of the worksheet for "Peacetime supplies and equipment" and hit 
ENTER.  Type 15 in the third column for "Wartime materiel" and hit ENTER. TurboBPR 
calculates the dollar figures by multiplying the total activity cost in the first row of the 
worksheet by the percentages you entered.
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As you allocate activity costs to the products/services, TurboBPR calculates the 
unallocated costs.  For activity A22, the unallocated costs are now $0.70 million, or 5% 
of the total cost for A22.  Notice that A22 Activity Cost = Peacetime supplies and 
equipment product cost + Wartime materiel  product cost + Unallocated costs ($14.00 = 
$11.20 + $2.10 + $0.70).

Now to see a roll-up of costs to the A0(summary) level, switch back to "A0 Provide 
Materiel".  Your screen should look like this:

Figure 3.8

We have allocated $57.20 million to "Peacetime supplies and equipment" and $9.60 
million to "Wartime materiel".  All other costs remain unallocated.

If you wanted to allocate all costs to your products/services, you would have to select 
each childless activity node and allocate its costs to the products/services.

Now click the Product/Service Cost button.   This screen provides a summary of product
and service cost data.  Click OK to exit the screen.
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Click OK to save your changes and close the screen.

Lesson Summary

In this lesson, you learned how to:

· Enter AS-IS Operations Cost
· Edit and transfer data from detailed worksheets to Operations Costs screen
· Modify an Activity Tree
· Enter Activity Based Costs
· Add and Delete Products and Services
· Enter data for Products and Services
· Allocate Activity Costs to Products and Services

In the next lesson, you will learn how to create initiatives and enter their associated costs 
and impacts.
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Lesson 4: Initiatives
Approximate completion time:  15 minutes

After completing Lesson 4 you will know how to:

· Create and link initiatives to strategies
· Enter initiatives 
· Enter initiative years and costs
· Delete initiatives
· Use the View Plan tool
· Enter the impact of initiatives on performance 
· Enter the impact of initiatives on operations costs

Understanding the Initiatives Worksheet

Now we will complete the linkage chain by relating Initiatives to improvements.  From 
the module button bar, click the Initiatives button.
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Your screen will look like this:

Figure 4.1

This screen completes the Goals-Performance-Strategies-Initiatives tree that we started in
Lesson 2.  This screen looks and works almost the same as the Strategic Planning 
Overview screen in  Module 1.  In this screen you will add a new initiative and link it to a
strategy.  Keep in mind that strategies are what we are going to do to decrease costs or 
improve performance.  Initiatives are how we are going to implement those strategies.
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Adding and Linking Initiatives

Click to highlight "S2 Improve readiness planning process."  Now click Add Initiative  
to create a new initiative.  Note that "Initiative Number 5" has been added under 
"Strategy 2."  Your screen should now look like this:

Figure 4.2
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Adding Details

Now double-click on "Initiative Number 5".  Your screen should look like this:

Figure 4.3

The cursor is in the text box labeled Initiative.  Let's give initiative 5 a title.  Overwrite 
"Initiative Number 5" with Electronic Customer Satisfaction 
Survey.  Now let's fill in the remainder of  the boxes on the screen.  Click in the 
Initiative Description text box.  Type in your own description of this initiative.  Next 
move the cursor to the text box labeled First Year and click on the box and change the 
year to 1996.  Expand the number of years for the initiative by selecting 5 as the 
Number of Years.  The initiative cost table enlarges to reflect the longer duration.  Now 
we can enter values in the worksheet.  Type in 10 below 1996, 9 below 1997, and so 
forth, finishing with 6 below 2000.  The graph updates with each change that you make.  
Note that this screen contains a Detail button that can be used in the same way as the one 
described in Lesson 3.  Click the Cancel button to cancel your changes and exit this 
screen.
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Deleting Initiatives

Click on Initiative 5.  Then click once on the Delete Initiative button located at the top of
the screen.  This button deletes the initiative that you highlighted.  Then click OK to 
close the screen and save the deletion.

Using the View Plan Tool

You have learned to create a chain of linkages from functional goals to initiatives.  Now, 
we'll use the View Plan tool to see all the links on one screen.  From the toolbar at the top
of the screen, click the View Plan tool (it looks like a tree with nodes).

Your screen will look like this:

Figure 4.4

This screen shows the entire Goals - Performance Measures - Strategies - Initiatives tree. 
Use this screen to check your work. When you finish, click OK to close the Project 
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Overview screen. 

Entering Impacts of Initiatives on Performance 

Click on the Initiatives button.  Now highlight the first initiative, "Prime Vendor Plus" 
and click on the Perf. Impact Button.  Your screen should now look like this:

Figure 4.5

Understanding the Performance Impact Screen 

Under the Initiative Name box you will find a list of performance measures, a gray 
rectangle indicating the unit of measure for the performance measure, and a worksheet.
The worksheet displays the current and target performance values by years.  These cells 
are gray to indicate that they are view-only.  You need to indicate how the initiative 
affects the value of the selected performance measure in a given year.

Click the mouse on the Performance Measure list box.  Select "percent orders delivered 
within 3/5 days".  Notice that TurboBPR displays the performance values for "percent 
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orders delivered within 3/5 days"  in the worksheet.  The worksheet shows the expected 
impact of the selected initiative on the selected performance measure.

Let's review the worksheet row by row.  The Current Performance row lists the current 
value of the performance measure that you entered in the Plan Module. The Target row 
displays the target level of the performance measure that you entered in the Plan Module. 
The row below this one, labeled Initiative Impacts on Perf., is where you enter the 
impacts of the initiative.

Entering Changes in Performance

The Initiative Impact on Perf. row shows that the Prime Vendor Plus initiative is moving 
the "percent orders delivered within 3/5 days" towards its target level.  For example, 
"percent orders delivered within 3/5 days" is affected by the "Prime Vendor Plus" 
initiative.  In 1997, Prime Vendor Plus causes the percent of orders delivered within 3/5 
days to increase by 25 percent, hence the 25 entry.  This is the type of data you would 
need to enter in this worksheet.  As written, the impact from this initiative alone does not 
allow us to meet out target every year through 2001.  It is important to understand that 
other initiatives can also impact this performance measure. Click Cancel to exit the 
Performance Impact screen.  

Remember, it is the aggregate of all initiative impacts that will help you to achieve your 
targets.  (For more detailed information, refer to the Alternatives and Alternatives 
Analysis sections in the Help document.)  Therefore, other initiatives may enable us to 
meet our targets each year through 2001.  If you look at the percent orders delivered for 
each initiative you find that the summations for each year meet the target value.  

Now you will learn how to enter the impact of initiatives on operation costs.  

Entering Impacts of Initiatives on Operations Costs

From the Initiatives screen, click to highlight "I2 Expedited  Prime Vendor."  Now click 
the Ops Cost Impact button.  When the Operations Cost Impact  screen opens, your 
screen should look like this:
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Figure 4.6

The Initiative Impact on Ops Cost row shows that the Expedited Prime Vendor initiative 
is causing operations cost to decrease.  In 1996, Expedited Prime Vendor causes 
operations costs to decrease by $20 million, hence the -20 entry.  This is the type of data 
you would need to enter in this worksheet.  Remember:  When an initiative causes costs 
to decrease, you enter negative impacts.  The graph at the bottom of the screen is a visual 
guide that allows you to see how the initiative cost impacts fluctuate over time.  The 
boxes labeled High(+%) and Low(-%) define how high above and how low below the 
most likely value cost impacts can extend.  (For more detailed information, refer to the 
Risk-Adjusted Discounted Cash Flows section of the Help document's Appendix.)

Click OK to close the Operations Cost Impact screen.  Click OK again to close the 
Initiatives screen.
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Lesson Summary

In this lesson, you learned how to:

· Create and link initiatives to strategies
· Enter initiatives 
· Enter initiative years and costs
· Delete initiatives
· Use the View Plan tool
· Enter the impact of initiatives on performance 
·    Enter the impact of initiatives on operations costs

In the next lesson, you will learn how to package initiatives into alternatives in order to 
analyze their performance and economic value.
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Lesson 5:  Alternatives
Approximate completion time: 15 minutes

In this lesson, you will learn how to:

· Package initiatives into Alternatives
· Analyze the Economic Value of Alternatives
· Compare the Performance of Alternatives

Packaging Initiatives into Alternatives

Click the Alternative module button.  The Package Initiatives screen appears.  Your 
screen should look like this:

Figure 5.1

An alternative is a set of initiatives to be analyzed as a single package.  Each alternative 
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gives functional management a complete view of the financial and operational impacts of
proposed changes. You can compare the cost and performance of the alternatives to the 
cost and performance of the baseline.

In this screen, you can create profiles for the baseline and three alternatives.  To include 
an initiative in the baseline or in an alternative plan, double-click the cell where the 
initiative and the plan intersect.  The cells marked as "yes" indicate that an initiative is 
included in the plan.  In the figure shown above, the baseline does not include any 
initiatives.

Let's add an initiative to the baseline.  Double-click the cell where "Prime Vendor Plus" 
row and the Baseline column intersect.  The cell changes from "no" to "yes," indicating 
that you have included the initiative as part of the baseline.

Analyzing Alternative Costs

In the lower right corner of the screen are two buttons.  Click the Economic Analysis 
button.  It takes a few seconds for the screen to appear.  When the Alternatives: 
Economic Analysis screen opens, your screen should look like this:
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Figure 5.2

The only information that you can change on this screen is the discount rate (the time 
value of money rate).  All of  the other information on this screen is view-only.

Let's focus on the bottom of the screen first.  At the bottom of the screen is a graph 
depicting baseline and alternative costs over the period of analysis.  For the baseline and 
any alternative, total cost equals AS-IS operations costs plus the sum of the costs and 
impacts of any included initiatives.

At the top of the screen is a worksheet containing values for a variety of financial 
indicators.

RADCF Savings: RADCF Savings Risk-Adjusted Discounted Cash Flow Savings (High, 
Expected, and Low).  This metric shows how much the alternative will save.  The Hi is 
the maximum savings and the Lo is the minimum savings.  If savings are negative then 
the alternative is more expensive than the baseline.  For Alternative A, the expected 
RADCF savings are $82.39 million.

ROI: Return on Investment.  This metric shows the year-by-year return on investment for 
each alternative.  For Alternative A, the ROI in 2000 is 225.01 %.

RA ROI: Risk Adjusted Return on Investment (High, Expected, and Low).  These figures 
show the return on investment for the entire period of analysis after adjusting for risk.  
For Alternative A, the RA ROI (expected) in 2000 is 220.13 %.  Notice that adjusting for 
risk lowers the ROI of the alternative.

IRR: Internal Rate of Return.  If the discount rate equaled the IRR then the alternative's 
net present value would be zero.  Alternative A's net present value would equal zero if the
discount rate equaled 89.05 %

Discounted Payback.  This metric indicates the number of years it takes for the 
alternative to break even.  Alternative A breaks even after a little more than 3 years from 
the beginning of the analysis.

Comparing Alternative Performance

Click OK to close the screen.  The Package Initiatives screen reappears.  Now click the 
Performance Comparison button.  The Alternatives: Performance Comparison screen 
opens.  Your screen should look similar to this.
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Figure 5.3

All information on this screen is view-only.  The worksheet at the top of the screen shows
the performance levels achieved by each of the alternatives.  Look at the cell where 
"percent of orders delivered in 3/5 days" and Alternative B intersect.  This cell is 
GREEN.  That means that Alternative B achieves the order-ship time performance targets
every year.

If a cell is yellow, that means that the alternative achieves the performance measure's 
targets in some (but not all) of the years.  If a cell is red, that means that the alternative 
never achieves the performance measure's targets.  The key in the middle of the screen 
explains this color coding.

Now look at the graph at the bottom of the screen.  This graph shows the annual 
performance achieved by the baseline and each alternative.  The Performance Measure 
list box above the graph allows you to pick the performance measure you would like to 
analyze.  Right now, "Percent orders delivered within 3/5 days" is displayed.  Click the 
list box and select "Average logistics overhead rate" from the list of performance 
measures.  After a few seconds, the Average logistics overhead rate Comparison graph is 
displayed.  As depicted in the worksheet at the top of the screen, Alternative B is the only 
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alternative that achieves the average logistics overhead rate targets for every year.

Click OK to close the screen.

Lesson Summary

In this lesson, you learned how to:

· Package initiatives into Alternatives
· Analyze the Economic Value of Alternatives
· Compare the Performance of Alternatives

In the next lesson, you will learn how to compare actual cost and performance data to 
projections.
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Lesson 6:  Actuals
Approximate completion time: 10 minutes

In this lesson, you will learn how to compare actual cost and performance data to 
projections.

When an alternative is approved and implemented, it becomes the new functional 
baseline.  However, this new baseline contains cost and performance forecast errors.  In 
the future, when actual cost and performance data become available, you can compare the
actuals to projections.  By tracking the actual cost and performance, you can refine your 
future years' forecasts.

Understanding the Projected versus Actuals Screen

Click on the Actuals module button.  The Projected versus Actuals screen appears and 
your screen should look like this:

Figure 6.1
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You will use the Projected versus Actuals screen to record actual cost and performance.  
You can enter:

1. The actual total cost for your function.
2. The actual cost for each initiative that's a part of the selected alternative.
3. The actual value for each performance measure.

TurboBPR pulls the target performance values from the Strategic Planning module.  The 
projected performance measure is the sum of these target values and the initiative impacts
of all included initiatives.  The initiative costs are pulled from the Initiatives module.  
Total (alternative) cost is the sum of the AS-IS operations costs + initiative costs + 
initiative impacts (for the included initiatives).

Selecting an Alternative and a Year

At the top left of the screen is a list of years from the historical period start year to the 
current year.  You can enter actuals for each year shown in the list.  "1995" is selected 
from this list.

At the top right of the screen is the Alternative list box.  Click the list box.  A list 
including the baseline and the three alternatives appears.   You can use this list to indicate
the alternative that you will be implementing.  Logistics selected "Alt B" as the 
alternative to implement.

Note:  You should only enter actuals for the one alternative that you implement.

Entering Actuals

We are going to enter actuals for 1995.  Click the mouse anywhere on the Total Cost row.
In the Actual column type in 159.65 and press ENTER.  TurboBPR calculates the 
difference between the actual value and the projected value (159.65 - 99.65 = 60.00).

Now, lets enter some actuals for the initiatives.  Enter  25.80 for "Expedited Prime 
Vendor" and 0.75 for "Readiness Planning BPR Project."

When you are finished, click OK to save your work and close the screen.

Lesson Summary

In this lesson, you learned how to compare actual cost and performance data to 
projections.  The next lesson will teach you how to create and print TurboBPR reports for
your project.
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Lesson 7:  Creating TurboBPR Reports
Approximate completion time: 15 minutes

After this lesson you will know how to create and understand a TurboBPR report.

Creating Reports in TurboBPR

You have completed the task of entering data into TurboBPR.  Now it's time to print your 
results.

Instructions:

1. Click the Report icon from the Tool Bar (it looks like a stack of papers).  This 
opens the Create Report Screen. 

2. The Report Format will be MS Word by default.  Users without Microsoft Word 
may create an ASCII file from which to print the report by clicking the white 
circle next to ASCII in the Report Format section. 

3.   Select which sections to print by clicking in the white box next to each section 
you wish to print.  A black X will appear in each selection you have selected to 
print.  Notice that clicking next to section 4.0 will select all of its subsections.  
You may "unselect" a section or subsection by clicking its white square again.  
The black X will disappear when a section or subsection has been "unselected."

4. Then click OK.  

If you are creating an ASCII file, you will select a name for the file to be created before 
the report is generated.  It takes a few minutes for TurboBPR to generate the report files, 
so a progress gauge appears on your screen. 

If the Report Format chosen is Microsoft Word, then TurboBPR will open Microsoft 
Word (if Turbo cannot find Microsoft Word, you will be asked to specify its path), and a 
macro will format the text and graphs.  Once the macro has finished running, use 
Microsoft Word's print features to send your report to the printer.

If the Report Format is ASCII, click YES when you are asked if you would like to view  
the report now.  
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Understanding the Report

The report has a cover page and five sections:  

· 1.0  Strategic Plan
· Mission and vision statements
· Descriptions of the goals, performance targets, and strategies
· Mapping of the goals, targets, and strategies

· 2.0  Operations Analysis
· Products and services with their volumes, unit cost, and total cost

            · Lists all the activities and their costs
            · Reports AS-IS Operations Forecast

· Reports the sources and amounts of unallocated costs for each 
activity

· 3.0  Initiatives
· Descriptions of each initiative
· Presents in table form the cost and performance impacts for each 

initiative
· 4.0  Alternatives

· Displays the package initiatives table which reports which 
initiatives comprise each alternative

            · Displays the economic analysis worksheet and performance
comparisons

· Graphical and tabular representations of the behavior of 
performance measures over time for each alternative

· 5.0 Actuals
· Tables of Predicted versus Actuals for total cost, initiative costs, 

and the performance measures
· Appendix

· Summary cost and performance tables and notes

When you are done viewing the report, click the gray control menu button in the upper 
left-hand corner of the screen to close Microsoft Word.  If you are viewing the ASCII 
report, click on the OK button to exit.

To exit TurboBPR open the File menu and choose Exit.  You will be prompted with a 
screen that asks you if you would like to save your project before you exit.  Click your 
desired option.

Lesson Summary

In this lesson you learned how to create and understand TurboBPR reports.
The next lesson will teach you how to convert Version 1.0 files into files formatted for 
Version 2.5.
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Lesson 8:  Using TurboBPR Converter
Approximate completion time: 5 minutes

After this lesson you will know how to convert Version 1.0 project files to files formatted
for Version 2.5.  If you don't have any Version 1.0 project files to convert, you should 
skip his lesson.

About the Turbo Converter

The Turbo Converter will not change your Version 1.0 project file.  After the conversion, 
you will have both the original Version 1.0 file and a new Version 2.5 formatted file.

Three things happen to Version 1.0 project data during conversion:

1.  A Version 2.5 project database is created with the name you choose.  This file 
stores most of your Version 1.0 project data.  Any data not found in this file will 
be stored in an ASCII file or in detailed worksheets.

2.  An ASCII file is created to store your Version 1.0 project notes.  You can open 
this file in Windows Notepad and paste the notes into any text box in TurboBPR 
Version 2.5.

3.  Detailed worksheets are created to store your Version 1.0 ABC, cost projection 
data, initiative cost items, and initiative impacts.

Opening the Turbo Converter

There are two ways to launch the turbo converter.  Since you have already exited 
TurboBPR, follow the first method for now.

1.  From the Windows Program Manager
Switch to the Windows Program Manager and open the TurboBPR 2.5 program 
group.  Double click on the Turbo Converter icon.  The TurboBPR Database 
Conversion application opens.

2.  From TurboBPR
At the top of the screen find the Converter icon in the icon menu bar.  It is 
between the calculator and support icons.  The Tooltip will say Converter.  Click 
on the Converter icon.  This will open the TurboBPR Database Conversion 
program.  
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Using the Turbo Converter

After you open the converter, do the following to perform the conversion:

1.  In the Welcome to TurboBPR Database Conversion screen, click the Start 
button.  
2.  In the Project File to Convert From dialog box which appears,  find the 
Version 1.0 project file you wish to convert.  Then click OK.
3.  In the Project File to Save As dialog box which appears, enter the name and 
location for the Version 2.5 file.  A default name is provided which you may wish 
not to change.  Note that the file should have the .bpr extension.  After you select 
the file name, click the OK button to start the conversion.

It takes a few minutes for the TurboBPR Converter to complete the conversion, so a 
process gauge appears on your screen.  After the conversion is complete, exit the 
converter by clicking on the Exit button in the Welcome to TurboBPR Database 
Conversion screen.  

You have now returned to TurboBPR.  Try opening the converted project file and 
examining the converted data.

Lesson Summary

In this lesson you learned how to convert Version 1.0 project files to files formatted for 
Version 2.5.
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Tutorial Summary
Congratulations!  You've now completed all eight lessons in the TurboBPR tutorial.  
You've learned to:

Enter goals, performance measures, and strategies
Build links between planning elements
Enter and edit AS-IS Operations Costs
Modify activity trees
Enter activity based costs
Enter products and services data
Estimate initiative investment costs
Estimate the impacts of initiatives on activity costs and performance
Package and evaluate alternatives
Compare actual cost and performance data to projections
Create TurboBPR reports.
Convert TurboBPR version 1 files to version 2.5.
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Appendix:  Windows Referenece

check box
When you click the box, an X appears in its center to indicate that the item has been 
selected.

clipboard
A temporary storage area for text or graphics that you are copying or moving from one 
location to another.

combo box
This window element is similar to the list box and text box combined.  It allows you to 
either type in your own value or select an item.

dialog box
A window in which you select options before TurboBPR carries out a command.

double-click
To rapidly press and release a mouse button twice without moving the mouse.  Double-
clicking carries out an action.  For example, double-clicking the TurboBPR icon starts the
application.

drag
Left click and hold down the mouse button on the object or selection, then move the 
mouse.

filename box
Displays the name of the open project.  It is positioned to the right of the Help tool.

insertion point
The place where text will be entered when you type.  The insertion point usually appears 
as a flashing vertical bar.
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list box
A window element that displays a pre-defined array of choices from which you can make 
a selection.  The values in a list box list are always displayed.

menu bar
The horizontal bar beneath the Application title bar that displays the name of TurboBPR 
menus.  The menu bar gives you access to many TurboBPR commands.

option button
When you click the button, a black dot appears in its center to indicate that the item has 
been selected.  In TurboBPR, option buttons are used when you can choose only one of 
the available selections.

scroll bar
Use to view additional columns or rows in a text box, worksheet, or list.

title bar
A horizontal bar located along the top of a window that displays the window's name.
Note  You can move a window or dialog box that has not been maximized by dragging its
title bar.  

toolbar
A bar with tool buttons that perform some of the most common tasks in TurboBPR such 
as opening and printing files.

ToolTips
Display the function of each toolbar button.  The figure below, displays the ToolTip for 
the Report tool.  When you point to a tool with the mouse, the tool name appears in a 
box. You can turn ToolTips on and off in the View menu.

11/10/94 3:26 PM

63



TurboBPR control menu
The menu in the upper-left corner of the TurboBPR window.  The control menu is located
to the left of the title bar.  It is designated by a short horizontal line rather than by a menu 
name.
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